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E STABLISHED IN 1976 (we’ll celebrate our 40th anniver-
sary next year), DMA is a group of Dayton–area profes-

sionals and hobbyists in the meld of computing and infor-
mation technology. General membership meetings are usual-
ly on the last Tuesday of each month. DMA has a number of 
Special Interest Groups (SIGs) in areas ranging from digital 
investing and genealogy to the Linux operating system. Each 
SIG meets according to its own schedule. DMA is a member 
of the Association of Personal Computer Users’ Groups 
(APCUG) and the Aoliated Societies Council (ASC). Click 
on any of the logos—including our own (top left)—to go to 
that organization’s Web site. 

Post Office Box 4005 
Dayton, Ohio 45401 

Telephone: 
(937) 222–4DMA 
(937) 222-4362 

Visit us at: 

DMA1.org 

Your 2015/16 
Oocers: 
President 
 Debra McFall 
Vice–President 
 Gary COY 
Secretary  
 Glady CAMPION 
Treasurer 
 Pat FLYNN 

Oocers need not be Trustees. 

Trustees: 
 Martin ARBAGI 
 Glady CAMPION 
 Gary COY 
 Patrick FLYNN 
 Debra MCFALL 
 Ken PHELPS 
 Ed SKUYA 
 Gary TURNER 
 Jim ULLOM 

Webmaster: 
 Dave LUNDY 

 

Submissions …  

T he Databus welcomes compliments, complaints, suggestions, and es-
pecially articles. We can accept articles in ASCII, or as attachments in 

Microsoft Word or Works, Open Office Writer, Word Perfect, or, yes, even 
WordStar (a word–processing program that goes all the way back 
to the 1980s!).  We can now also accept PDF files. Send articles to: 

Editor@DMA1.org 

 All articles are subject to editing for spelling, grammar, usage, and 
space. Always retain a copy of your work, as The Databus cannot be re-
sponsible for loss. When articles are of roughly equal quality, those by 
paid–up DMA members usually receive preference. 

A ll registered trademarks, for example: DMA, Amazon, Dell, or Mi-
crosoft Word, are the property of their respective owners. However, 

for better readability, the Registered Trade Mark symbols (® or ™) have 
been omitted. The Editor occasionally inserts comments into articles. Such 
comments are usually in square brackets [ like these] and are always pre-
ceded by the phrase: “Editor’s Note.” 
 The Databus is written and published by volunteers. We do not give pro-
fessional advice on computer, network, or software installation, trouble-
shooting, or repair. If you need expert assistance, please seek the services 
of a competent professional. 

http://www.dma1.org/
http://apcug2.org/
http://www.ascdayton.org/
http://www.dma1.org/
mailto:Editor@DMA1.org
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November Meeting: Gaston Brown: THE EVOLUTION OF 
GAMING—HOW IT TOUCHES EVERY FACET OF MODERN LIFE 
7:00 P.M., Tuesday the 24th, at T. J. Chump’s, 7050 Executive Blvd, Huber Heights  45424 

Click here for a map. No charge—Guests welcome—Bring a friend 
Meeting starts at 7:00 P.M., but come at 6:00 if you want dinner. 

T 
HIS MONTH, WE WILL LOOK AT how gaming on the PC, console, and on social media has become 

ingrained in many areas of modern-day life, ranging from the technology we use everyday to how 

we build our résumés and search for jobs. The recent explosion of E-sports, along with social media 

streaming and online viewing of E-sports events habe re-ignited the gaming movement, expanding it 

in new directions. As a result, the gamer community has grown and gained greater acceptance as com-

pared to the early days of DaytonLANfest. We will also discuss how gaming hardware has evolved in 

the last 10 years and how gamers are able to influence the development  

 Gaston Brown 

Also known as Sideout, he has been involved in LAN party gaming since 2000. Gaston is Assistant Di-

rector for NeXus LAN in Miamisburg (nexuslan.org) and Network/Server Administrator for LanOC in 

Van Wert (lanoc.org). Gaston resides in Troy, OH with his two children and is an avid bracket racer  

of both his 2006 Mustang GT and 2014 Dodge Ram 1500 pickup. 

 We continue to meet at 

the T. J. Chump’s in Huber 

Heights. Same great cuisine as 

the Fairborn restaurant, and 

this location is quieter. It’s 

just off I-70, exits 36 (if you’re 

going east [for example, com-

ing from Englewood]) or 38 (if 

you’re going west [for exam-

ple, coming from Spring- 

jer’s. There’s plenty of free 

parking. Click here for a map. In addition, T. J. Chump’s in Huber Heights is accessible via RTA bus 

routes #18 (Meijer’s and Executive Boulevard stop) and 19 (same bus stop—click on the route num-

bers for maps and schedules). All DMA meetings are free and open to the public, so please bring a friend. 

(Since the main meeting will be at a restaurant, there will be no 

Pizza SIG gathering afterward.) 
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g 
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https://www.google.com/maps/place/7050+Executive+Blvd,+Dayton,+OH+45424/@39.8700739,-84.1077,16.5z/data=!4m2!3m1!1s0x883f7d212c61a39f:0xfe89b58f6eda29b9
nexuslan.org
lanoc.org
https://www.google.com/maps/place/7050+Executive+Blvd,+Dayton,+OH+45424/@39.8700739,-84.1077,16.5z/data=!4m2!3m1!1s0x883f7d212c61a39f:0xfe89b58f6eda29b9
http://www.i-riderta.org/sites/default/files/schedule_pdf/RTA-Route18_3.pdf
http://www.i-riderta.org/sites/default/files/schedule_pdf/Rt%2019%20schedule%2010-25-15.pdf
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M inutes are usually published almost two months late. This is because the Minutes for, say, 
the October Board meeting must be approved by the Trustees at the following month’s 

meeting—in this case, early November. The corrected and approved October Minutes will thus ap-
pear in this (November) issue, published toward the end of the month. The next Trustees’ meeting 

will be on December 2 at the Chestnut Street Community Room of the Greene Shopping Mall. The 
meeting begins at 7:00 p.m. (Please come at 6:00 if you’re joining us for dinner at nearby Panera. (Click 
here for a map.) 

MINUTES 
DMA Board of Trustees-Meeting of Monday, 5 October 2015 

CALL TO ORDER 

 The meeting was called to order at 7:30 P.M. by Gary Coy. Trustees present: Martin Arbagi, 
Glady Campion, Gary Coy, Pat Flynn, Debra McFall, Eric Ottoson, Ken Phelps, Ed Skuya and 
Gary Turner, Jim Ullom. 
OFFICERS’ REPORTS 
President-Gary Coy 
 TJ Chumps seems to be a good meeting place for us. 
Vice President-Eric Ottoson 

 No report. 
Secretary-Debra McFall 

 Debra presented the Minutes for the September Board meeting. Eric Ottoson moved the 
Minutes be accepted with changes. Jim Ullom seconded and the motion passed. 
Treasurer-Glady Campion 

 Glady presented a revenue and expense report for January 1-September 30, 2015. Our Fifth 
Third Checking Account has a balance of $18,484.61. Our Fifth Third Savings Account as a bal-
ance of $11,220.07. Our Dayton Foundation Account has a balance of $78,886.22. Our Paypal Ac-
count has a balance of $705.12. This gives us a total of $108,898.52. 
COMMITTEE REPORTS 

Audit-Glady Campion 

 No report. 
Bylaws Review-Eric Ottoson 

 Eric is nishing bylaws updates and then they will be presented to the Board for approval. 
Funding—Open 
 No report. 
Membership-Glady Campion 
 We have 67 regular members, 3 associate members, 0 student members and 2 life members for a 
total of 72. There were 38 people at the August meeting and the 50/50 brought in $31. 
Net Admin Team-Ken Phelps, Gary Turner 

(Continued on page 5) 
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 Gary Turner needs to check Google Apps to make sure everything is in order and that DMA is 
disconnected from the Dallas Museum of Art. 
 Our Web site could use some updating, so we are considering using Wordpress. We need vol-
unteers to help with this project. If you have Web site building knowledge, we could use your as-
sistance. 
Programs-Jim Ullom 
 Chris did a great job on the Digital Forensics presentation for September. In October, Cathe-
rine Devlin will give a presentation on what information the government has on you and how to 
get it. In November, Martin Arbagi will give a presentation on Keypass. Future presentations may 
include Dayton Drones and Of ce 365 and 2016. 
Publications-Martin Arbagi 
The August/September DATABUS is out. 
OLD BUSINESS 
Advertising-Ed Skuya 
 We will advertise in the City Paper again since the ad is free. We may also advertise in the “Go” 
section of the Dayton Daily News. Ken Phelps will check up on the price of a Meet-Up ad online. 
Storage Locker Clean-Up Committee-Debra McFall, Glady Campion 
 The storage locker is cleaned out and we have closed the account with Public Storage. The Rec-
ords Committee will meet to develop standards on which records are kept and for how long. 

(Continued from page 4) 

(Continued on page 6) 

Have a business card? Are you a DMA member? 

A ny paid–up member of the Dayton Microcomputer Association is entitled to a free business card–

sized advertisement in The Databus. At this month’s meeting, give your card to Editor Martin 

Arbagi to be scanned, or send a good–quality image to Editor@DMA1.org A link to your Web site (if 

you have one) can be embedded in the image of your card. Under weird IRS regulations, your site may 

not include discount coupons for DMA members, although discount offers may be included in the ad-

vertisement itself. See the example below right, which includes a member discount. 

 

10% Discount to DMA 
members! 

mailto:gcoy@woh.rr.com
mailto:Editor@DMA1.org
http://locknestmobilelocksmith.com/
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Help DMA by using Amazon’s 

“Smile” program! 

A mazon, the Internet’s largest retailer (if you haven’t no-
ticed, Amazon isn’t just for books any more!) has a “Smile” 

feature whereby Amazon donates a percentage of almost any 
purchase you make to a selected nonprofit organization. There is 
no extra cost to you. Click here to learn more or here to go di-
rectly to the sign-up page. Be sure to put DMA down as the 
beneficiary of your purchases. 

Board Meetings-Glady Campion 
 The next Board Meeting will be held on Monday, November 2, 2015 at 7 P.M. at The Greene 
Community Room on Chestnut Street near the Ritch Building. If you would like to eat with us 
rst, please come at 6:00 P.M. to Noodles and Company, 11 Greene Boulevard, Beavercreek, Ohio 
45440. 
NEW BUSINESS 
 We had election of new of cers and the results are:  Debra McFall, President; Gary Coy, Vice 
President; Pat Flynn, Treasurer; Glady Campion, Secretary. Jim Ullom moved to elect the of cers,  
by acclamation. Martin Arbagi seconded and the motion passed. Congratulations to the new of -
cers. 
VOLUNTEER OF THE YEAR 
 Debra McFall has been nominated for Volunteer of the Year. 
GOOD OF THE ORDER 
 Our club was formed in 1976, so we are celebrating our 40th anniversary in April of 2016. We 
will take a few minutes at April’s main meeting to remember the club’s Founding Members. 
ADJOURNMENT 
 Jim Ullom moved to adjourn at 8:43 P.M.  Eric Ottoson seconded and the motion passed.  

Respectfully Submitted, 

Debra McFall, Secretary 

(Board of Trustees’ Minutes—Continued from page 5) 

https://smile.amazon.com/about/?ref=spkl_3_0_2055499922&ie=UTF8&pf_rd_m=ATVPDKIKX0DER&pf_rd_s=desktop-auto-sparkle&pf_rd_r=08XEYSPQPYZ9W0BKR5WF&pf_rd_p=2055499922&pf_rd_t=301&pf_rd_i=amazon%20smile&qid=1427474572
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—Musings: An Irregularly Written Column— 

By A. A. ARUNDEL 
Dayton Microcomputer Association, Inc. (DMA1.org) 
November 2015 

T 
HOSE OF US WHO HAVE BEEN AROUND A LONG TIME remember when Systemax was a local Miami 

Valley computer wholesaler. The company grew and was eventually part of Tiger Direct and 

Global computer products. Well, Systemax and its divisions have been acquire by PCM. Supposedly, 

the deal will be closed in December. PCM is a large computer services company and with this acquisi-

tion may be positioning itself to be a much larger player in the global computer market. 

 Speaking of mergers, let’s not forget the 67 billion dollar deal of Dell buying EMC. Employees of 

EMC want to know what happens to their jobs, stock options, and to their retirement savings. Work-

their questions. Evidently, neither EMC nor Dell have not been very forthcoming with information. It 

should be interesting to see what happens. Especially, since EMC has been in a cost cutting mode for a 

while, they are rumored to be closing or getting rid of non-  

 I still get questions about smart watches, but I am not yet totally convinced of their large scale use-

fulness. Just to confuse things, Hewlett-Packard is developing smart watch technology. They may not 

market their own version of the smart watch, but rather may be building the guts of the smart watch 

to be branded by other companies around the world. 

 For those of you looking for Black Friday or Holiday shopping deals, I’d keep an eye out for price 

drops on Solid State Drives (SSDs), thumb drives and tablets.  I am sure there will be many other com-

puter goodies and electronic devices on sale. 

 Good shopping and happy holidays to everyone. 

 By the way, don’t forget the DMA holiday dinner. It at the Huber Heights T. J. Chump’s on Decem-

ber 15.  Starting time is 6:00 P.M. [Editor’s Note: See page 12.] 
—Control Layout in Word With Page and Column Breaks— 

Part 2 of Two Articles  
Nancy DEMARTE, 1st Vice President, Sarasota Technical User Group, FL 
October 2014 issue, Sarasota Technology Monitor 
www.TheStug.org  
ndemarte (at) Verizon.net 

L 
AST MONTH we examined the Page Break tools in MS Word. This month we’ll explore how to use 

the Section Break tools. Many home Word users ignore these tools because they think they only 

(Continued on page 8) 

DMA1.org
http://www.thestug.org
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apply to very long documents. But section breaks can help you format a short document, even a single 

page, in special ways. We’ll look at two uses of section breaks in short documents:  

1. combining full page text with text in columns on one page and  

2. creating different headers, footers and margins in a document with two or more pages. 

What are Section Breaks? 

 Section breaks are similar to page breaks in that they divide parts of a document; they differ in that 

you can have several sections on one page, if needed, and can format each section differently. 

Section Break Styles: 

 There are four styles of section breaks. They appear in the Breaks gallery on the Page Layout tab, 

one, Next Page, inserts a new section on the next page. This is useful, for example, if you have a title 

page where you don’t want the header or footer that appears in the rest of the pages.  The next style, 

Continuous, inserts a section break on the current page, as in my example in Figure 2. The last two 

options, Even Page or Odd Page, insert section breaks which begin on the next even or odd page. This 

might be desirable with a chapter book, where each chapter needs to begin on the right hand page.  

Inserting and Deleting Section Breaks: 

 Inserting and deleting a section break is done the same way as a page break. Insert a break by 

clicking in the spot where you want the break to occur, and then click the type of break you want. De-

lete a break by dragging over the break indicator in the document and then pressing the Delete key. If 

you have trouble selecting the break indicator, 

try dragging slightly diagonally down as you 

drag across the entire dotted line. 

Project 1: Putting columns on the same page 

as full page text 

 Figure 2 illustrates a use of section breaks 

where you create a page of text that is both full 

page width and in columns. It might look like 

this: ————————————————> 

In this example from an old article of mine, I 

added two section breaks in order to emphasize 

a central paragraph by making it two columns. 

First, I typed the entire document. This is al-

ways a good idea with Word documents—draft 

(Continued from page 7) 

(Continued on page 10) 

Figure 1 - the Section Breaks gallery 



November 2015         The Databus                  Page 9 

Click anywhere on the DMA Calendar (above) 

to go to the original at DMA1.org. 

http://www.whitewatervalleyrr.org/
http://www.dma1.org/cgi-bin/webcal.pl
https://www.youtube.com/watch?v=ULesybnILFs
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—SIG News— 

S IGS ARE SPECIAL INTEREST GROUPS, an unusual feature of DMA. They range from the obvious 

(dynamic computer languages and the Linux operating system) to the not so obvious (genealogy 

and investments). All DMA SIGs emphasize the uses of digital technology and tools for business, hob-

bies, or other special interests. DMA Bylaws require all SIG to be members of DMA. We 

encourage all SIG members also to join the parent organization.  

 Send announcements for your SIG to Editor@DMA1.org. Two things to remember: 

 Leave notices of regular meetings to the DMA calendar. (See page 9.) However, notic-
es of special events, cancellations, or postponements are welcome. 
  Please give us enough time. THE DATABUS comes out at the end of each month. A notice 
of an event that occurs, say, on the 19th of December would not be published in the January 
issue of THE DATABUS until after your meeting had taken place. (There will be no December 
issue.) It should have been in this (end of November) issue. 

J AY FINLEY, leader of the Genealogy SIG, apologizes for missing the 
November meeting, and informs us that there will be no Decem-

ber meeting because of the DMA Holiday Dinner (see page 12.) The 
next meeting will be on Thursday, January 7, 2016, at 6:30 P.M., at 
the East Branch of the Dayton Public Library. 

the content of a document all at once to let the ideas flow, then apply formatting, making changes as 

needed. Next I turned on the Show/Hide tool, found on the Home tab in the top right corner of the 

Paragraph group. Having this tool 

turned on lets me see where the sec-

tion break indicators are located,  

which is important in case I need to 

delete or move one. My next step was 

to click at the end of the paragraph 

which would stay full page width and 

add a continuous section break, as 

described above. I repeated that pro-

cedure to add another continuous 

section break at the end of the para-

graph I planned to format in columns. 

Finally, I clicked inside the text be-

(Continued from page 8) 

(Continued on page 11) 

Figure 2 - Page with columns and full page text 

mailto:Editor@DMA1.org
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tween the section breaks and clicked the Page Layout tab—Columns—Two to create two columns. 

This use of section breaks works well for newsletters, too, where you have a banner headline across 

the page with columned articles below. 

Project 2: Different Headers and Margins in the same document 

 Sometimes you have two or more pages in the same document which you need to format different-

ly, such as a title page and body of a document. Using section breaks lets you add different footers or 

the same footer, but the page two margins are wider than those on page one. This was all done using 

section breaks. 

 First I typed the entire two pages, paying no attention to format, and turned on the Show/Hide 

tool. I added a header (Insert tab – Header) and typed the author’s name and address, which appeared 

on both pages. Then I clicked at the end of the page one article and inserted a Section Break – Next 

Page, as described above. To get rid of the header on page two, I had to break the link between the pag-

es. I clicked a random spot in page two and clicked the Insert tab – Header – Edit Header. Then I 

clicked inside the header and, on the Header & Footer Tools tab, which only appeared when I was in 

the header, clicked “Link to Previous” to remove the link between the two pages. Finally, I selected the 

header text on page two and deleted it, leaving the header intact on page one. 

Notes and Tips: 

1. When you delete a section break, you may get an unexpected result if you don’t understand how 

section breaks work. A section break controls formatting of the text before it. Therefore, when you de-

lete a section break, the formatting from the section just after that section will be applied to the section 

before the now-deleted break. If this is not what you want, click the Undo button to restore the break 

and rethink what look you really want. It helps to plan out any multi-page document which has sec-

tions so that you can insert the correct style of break in the right spot. 

2.  A Section Break – Next Page and a Page Break might seem to be the same, but only the section 

break will allow you to have different formatting in different sections. 

3. When adding section breaks, save your work (Ctrl+S) more often than Word does, which is about 

every 10 minutes. 

 Stretch your skills and try one of these projects with section breaks.                                                               … TDB 

(Continued from page 10) 

Wanted: Typist (on PC)  Contact: Wynn Rollert (DMA Member) 
Accuracy: Important                     (937) 256–1772 
Speed: Not as Important                                 … at any time 
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By Jove, Harrington, isn’t this 
more exciting than attending 
the Annual DMA Holiday Din-
ner at T. J. Chump’s with all 

those nerds and geeks? 

You and your fing 
time machine! 

/ Poor Harrington is now long gone, but you can come! 

/ Cost: $25.00—cheap! 

/ We’ll meet on Tuesday, December 15, at T. J. Chump’s in fashionable 

suburban Huber Heights. (Click here for a map.) 

/ Attitude adjustment (cocktails) at 6:00 p.m., dinner at 7. (Cash bar.) 

/ Lots of door prizes—almost everyone wins! 

/ Tickets available now from Glady Campion! 

r v t
 

E o 

YAAaaaargh!! 

v 1 

m 

http://www.meatballs.com/
https://www.google.com/maps/place/7050+Executive+Blvd,+Dayton,+OH+45424/@39.8700739,-84.1077,16.5z/data=!4m2!3m1!1s0x883f7d212c61a39f:0xfe89b58f6eda29b9
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DMA Membership Application/Renewal 

PLEASE ALLOW UP TO THREE WEEKS FOR APPLICATION PROCESSING AND INTERNET SET–UP 
 

Name: ____________________________________________________________________Birth date:_____/_____/_____ 
 mo. day year 

 
Associate Name: ____________________________________________________________Birth date:_____/_____/_____ 

 mo. day year 
Address: ____________________________________________________________________________________________ 
 
City: ___________________________________________________________________ State: ________ Zip: __________ 
 
Phone: (Home) (________) ___________-_____________ (Work) (________) _________–______________x___________ 
 

I wish to have my name and address published in the club roster: YES  NO  

 
E–mail address: ____________________________________________@________________________________________ 
 
 
Name of DMA member who recruited me: _______________________________________ (only new regular memberships)  
 
Are you a current or recent DMA Member? Yes q No q Change of Address only? q Today’s date: _____/_____/_____ 

 
If you are renewing, please give your Membership Number (from your membership card) _________________________ 

Type of Membership 
 

Application is for: New Membership  Membership Renewal  Associate Membership*  
 

If applying for free student membership, please give school name and student ID number: Available only for students un-
der 22 years old. (Student Members cannot vote in DMA elections.) 

 
School Name: ______________________________________________ Student ID#: _______________________________ 
 

* A family or associate membership is an additional membership for a member of your immediate family or someone else who is liv ing in the member’s 
household. If this is a family or associate membership, give name of regular member:  
 

Dues/Fees (Dues and Fees are subject to change without prior notice): 
 

Membership (one year — New or Renewal)  1.)  $25.00 

 

Family or Associate Membership (must live at same address as regular member)  2.) $12.50 
 

Free Student Membership for students under 22 yrs of age. (Student Members cannot vote in DMA elections.) 
  3.)  FREE 
 

Please assign me a user ID for E–mail and Usenet news access one–time setup 4.)  $10.00 
fee for new E–mail accounts. 
 

Total — Lines 1 and 2 (+ 4 if checked)  5) $_____________ 
 

Make your check payable to Dayton Microcomputer Association, Inc. (DMA), and then send the check and application to: 
 PO Box 340402 
  Beavercreek, OH 45434–0402 
DMA Use only: Membership # __________________  
Exp. Date: __________/_________/______________ 
Processed by: ________________________________ 
REV: 25 November 2013 

Cash 

Check 

Check # ____ 

Click here to pay your dues 
using PayPal. Simplified 
Membership Form, too! 

http://www.dma1.org/dma_member_form.html

